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Tecan Customer Support 
If you have any questions or need technical support for your Tecan product, 
contact your local Tecan Customer Support organization. Go to: 
http://www.tecan.com/customersupport  for contact information. 
Prior to contacting Tecan for product support, prepare the following information 
for the best possible technical support (see name plate): 
• Model name of your product 
• Serial number (SN) of your product 
• Software and software version (if applicable) 
• Description of the problem and contact person 
• Date and time when the problem occurred 
• Steps that you have already taken to correct the problem 
• Your contact information (phone number, fax number, e-mail address, etc.) 

 
  

http://www.tecan.com/customersupport
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WARNING 

CAREFULLY READ AND FOLLOW THE INSTRUCTIONS PROVIDED 
IN THIS DOCUMENT BEFORE OPERATING THE INSTRUMENT. 

Notice 
Every effort has been made to avoid errors in text and diagrams; however,  
Tecan Austria GmbH assumes no responsibility for any errors that may appear in 
this publication. 
It is the policy of Tecan Austria GmbH to improve products as new techniques 
and components become available. Tecan Austria GmbH therefore reserves the 
right to change specifications at any time with appropriate verification, validation, 
and approvals.  
We would appreciate any comments on this publication. 

 
Manufacturer 

Tecan Austria GmbH 
Untersbergstr. 1A 
A-5082 Grödig 
T +43 62 46 89 330 
F +43 62 46 72 770 
E-mail: office.austria@tecan.com 
www.tecan.com 

Copyright Information 
The contents of this document are the property of Tecan Austria GmbH and are 
not to be copied, reproduced, or transferred to another person or persons without 
our prior written permission. 
Copyright  Tecan Austria GmbH  
All rights reserved. 
Printed in Austria. 

About the Instructions for Use 
This document is intended as a reference and Instructions for Use for the 
HydroControl software, which is designed for defining and editing programs for 
the HYDROFLEX Washer via computer.  
This document instructs how to: 
• Install the software 
• Operate the software 

Remark on Screenshots 
Data and parameters displayed in screenshots vary depending on the instrument 
connected. Details and examples are described in the respective Instructions 
for Use of the instrument connected. 
The version number displayed in screenshots may not always be the one of the 
currently released version. Screenshots are replaced only if content related to 
application has changed. 
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Warnings, Cautions and Notes 
The following types of notices are used in this publication to highlight important 
information or to warn the user of a potentially dangerous situation: 

 

Note 
Gives helpful information. 

 

CAUTION 
INDICATES A POSSIBILITY OF INSTRUMENT DAMAGE OR DATA LOSS 

IF INSTRUCTIONS ARE NOT FOLLOWED. 

 

WARNING 

INDICATES THE POSSIBILITY OF SEVERE PERSONAL INJURY, LOSS 
OF LIFE OR EQUIPMENT DAMAGE IF THE INSTRUCTIONS ARE NOT 

FOLLOWED. 

 
 

Symbols 
 

 
Manufacturer 

 
Consult instructions for use 

 
Biological risks  

 
Possible presence of a strong magnetic field 
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1. Introduction 
1.1 Intended Use 

HydroControl is the control software for the HYDROFLEX plate washer. It is 
designed for defining and editing programs, plate parameters, and instrument 
settings via a computer. The plate washer and included software should only be 
used by trained personnel according to the Intended Use of HYDROFLEX. 
Before operating the plate washer with HydroControl software carefully read and 
follow the instructions provided in this document as well as the Instructions for 
Use of the HYDROFLEX washer. 

 

Note 
It is important to note that the proper installation of the instrument and 

the HydroControl software alone will not ensure compliance with all 
regional and national laws and requirements. Corresponding policies 
concerning processes and standard operating procedures, including 

validation and quality control, must also be established. 

 

1.2 User Profile 
1.2.1 Professional User – Administrator Level 

The administrator is a person who has suitable technical training and 
corresponding skills and experiences. If the product is used as intended, the 
person is able to recognize and avoid dangers. 
The administrator has extensive skills and is able to instruct the end user or the 
routine user in assay protocols in connection with a Tecan product within the 
bounds of the intended use. 
Computer application skills and good English skills are required. 

1.2.2 End User or Routine User 
The end user or routine user is a person who has suitable technical training and 
corresponding skills and experiences. If the product is used as intended, the 
person is able to recognize and avoid dangers. 
Computer application skills and good language skills for the respective national 
language at the installation site and English are required. 

 

Note 
Training dates, their duration and frequency are available at your 

customer support. 
Address and telephone number can be found on the web: 

http://www.tecan.com/customersupport 

 
  

http://www.tecan.com/customersupport
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1.3 Specifications 
1.3.1 System Requirements 

The following system requirements have to be met to use the HydroControl 
software: 

 Minimum Recommended 

PC Windows compatible PC with a Pentium 
compatible processor running at 1 GHz (Dual 
Core) 

2 GHz (Dual Core) 

Operating 
System 

Windows XP (32-bit) – SP3 
Edition: Professional 

 

 Windows 7 (32-bit) – SP1  

 Windows 7 (64-bit) – SP1 
Editions: Professional, Ultimate, Enterprise 

Windows 7 (64-bit) – SP1 
Edition: Professional 

 Windows 8 (32-bit)  

 Windows 8 (64-bit)  
Editions: Pro, Enterprise 
Windows RT NOT supported! 

 

 Windows 10 (32-bit)  

 Windows 10 (64-bit)  
Editions: Pro, Enterprise 

 

Memory Windows XP: 512 MB RAM 1 GB RAM 

 Windows 7, Windows 8, Windows 10  
(32-bit): 1 GB RAM 

 
2 GB RAM 

 Windows 7, Windows 8, Windows 10  
(64-bit): 2 GB RAM 

 
4 GB RAM 

Space 
Requirements 

2 GB 6 GB 

Monitor Super VGA Graphics  

Resolution 1024 x 768 1280 x 1024 

Color Depth 8-bit  

Mouse Microsoft mouse or compatible pointing device  

Communication 1 x USB 2.0 2 x USB 2.0, USB 3.0 Port 
1 x RS232 (Serial) 

Devices 1 x CD-ROM drive 
 
Windows 7, Windows 8, Windows 10: 
DirectX 9 graphics device with WDDM 1.0 or 
higher driver 
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 Minimum Recommended 

.NET Microsoft .NET Framework 3.5 (SP1): 
In Windows versions prior to Windows 8, the 
required .NET version is installed automatically 
alongside any existing versions. 
Windows 8, Windows 10: 
The user will be prompted to install the 
required .NET framework, if it is not already 
present. 

 

 
 

1.4 Packing List 
Content of data medium: 
• HydroControl V 4.3 
• EVOware Washer Driver V 4.3 
• Fluent Washer Driver V 4.3 
• Manuals 

 
 

1.5 Installation and Uninstallation 
1.5.1 Installing the Program 

 

CAUTION 
IT IS VERY IMPORTANT THAT THE PERSON WHO INSTALLS THE 

HYDROCONTROL SOFTWARE HAS SYSTEM ADMINISTRATOR1 RIGHTS 
ON THE COMPUTER. 

HydroControl is installed by a software setup program. All of the necessary 
components are installed automatically. 
The software is installed using the following procedure: 
1. Insert the HydroControl data medium into the appropriate drive. 
2. The Main page of the user interface appears. Click Main. 
3. On the next screen click on Software and then on Install HydroControl. 
4. A series of screens will appear, read each one, enter any necessary 

information and click Next to continue. 
5. The files are installed and the program icon is created. 
6. When the Installation Complete dialog box appears, click Finish and the 

program is ready to be used. 
7. Store the HydroControl data medium in a safe place in case the software 

needs to be reinstalled. 
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1.5.2 Uninstalling the Program 

 

CAUTION 
IT IS VERY IMPORTANT THAT THE PERSON WHO UNINSTALLS THE 

HYDROCONTROL SOFTWARE HAS SYSTEM ADMINISTRATOR1 RIGHTS 
ON THE COMPUTER. 

1 See 4 User Administration for differences between User Administrator, 
Hydro_Administrator and System Administrator. 
If necessary, the software is uninstalled using the following procedure: 
1. Go to Start menu, point to Settings and then choose Control Panel.  

The Control Panel window appears. 
2. Choose Add/Remove Programs in case of Windows XP, or Uninstall a 

program in case of Windows 7, Windows 8 and Windows 10.  
The respective window appears. 

3. From the list of installed programs, choose HydroControl and click 
Change/Remove or Uninstall. 

4. Follow the instructions on the screen.  
5. Once all the files have been removed successfully, click Finish and the 

program is uninstalled and no longer listed in the Add or Remove Programs 
window. 

The uninstall application also offers the possibility of uninstalling all components. 
Select whether user data should be deleted as well. 
 
In this case all server and user administration components (and any associated 
Help files and Registry entries) will be removed. 
Effect: All users will be erased. 
Decide if you want to uninstall the user administration as well. A new user 
administrator has to be created next time the application is installed. 
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1.6 Installation Notes 
Installing HydroControl 4.0 or higher when Magellan 6.6 or older is installed or 
HydroControl 3.0 or older is installed. 

Perform the Setup for the HydroControl 4.0 or higher software as described in the 
IFU.  
If Magellan 6.6 or older is installed, the Migrate dialog box for the Magellan 
software appears: 

 
Click OK.  
The Login dialog box appears: 

 
If you wish to transfer user information from Magellan to HydroControl 4.0 or 
higher, enter the User Name and Password for Magellan and click OK. If you do 
not wish to transfer the user information, click Cancel. If you are unsure about 
what to do, click Cancel. 
If you click Cancel, you can still define this user information manually later. If you 
click OK, you can also define new user information manually, but any user 
information transferred from Magellan cannot be removed later. 
If HydroControl 3.0 or older is installed, the Migrate HydroControl Database 
dialog box appears: 

 
Click OK.  
The Login dialog box appears: 

 
If you wish to transfer user information from the previously installed HydroControl 
software to HydroControl 4.0 or higher, enter the User Name and Password for 
the previous HydroControl and click OK. If you do not wish to transfer the user 
information, click Cancel. If you are unsure about what to do, click Cancel.  
If you click Cancel, you can still define this user information manually later. If you 
click OK, you can also define new user information manually, but any user 
information transferred from the previous HydroControl software cannot be 
removed later. 
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Continue the installation of the HydroControl 4.0 or higher software as described 
in the IFU. 

 
Start the HydroControl 4.0 or higher software. When starting the first time and if 
no user information has been transferred from Magellan or previous HydroControl 
software, the following dialog box appears: 

 
Click OK and the Create User dialog box appears: 

 
Please be aware that the suggested login information can be changed. After the 
User Name, Full Name, Password and Confirm Password have been entered, 
click OK to proceed.  
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2. Starting HydroControl  
Connect the instrument to the computer and switch the instrument ON. 
Start the program from the Start menu: Programs/Tecan/HydroControl. 
The Connect command from the Instrument menu can be selected only when 
the Program menu is visible on the instrument’s display. 
HydroControl can also be used in simulation mode for creating and editing 
programs when no instrument is available. 

2.1 User Administration Quick Start  
For a more detailed description, see 4 User Administration. 
When the HydroControl software is started the first time after installation, a User 
Administrator password must be defined, (see 4.1.1 Logging in for the First Time 
for more information). By default the user name for the User Administrator1 is 
Admin. 
After successfully entering the user administrator password, the user 
administration database is set up with default user groups and users and the 
User Administration dialog box appears.  
The default user groups are as follows: 
• Hydro_Administrator1 
• Hydro_Application_Specialist 
• Hydro_Operator 
The default user and membership is as follows: 
• Admin 
Full name: Administrator 
Initial Password: To be set at first startup 
This is the User Administrator1. Do not confuse the User Administrator with the 
Hydro_Administrator. 
The default settings can be changed now (or at any time later, if the logged in 
user has User Administrator rights). New users and user groups can be added 
and modified. 
Individual groups and users have a name, (Group Name and User Name 
respectively), which cannot be changed once entered and saved. Users also 
have a Full Name that can be changed later. 

 

Note 
Usually, the User Administrator should only have rights to set up users 
and user groups and assign rights to them. It is recommended that the 

User Administrator has no rights on the application itself! 

Any user can also be a User Administrator1, regardless which user group he 
belongs to, but it is not recommended to give users System Administrator1 
rights!  

 

CAUTION 
IF THE USER ADMINISTRATION PASSWORD IS FORGOTTEN,  
USER ADMINISTRATION SETTINGS CANNOT BE CHANGED  

AND THE HYDROCONTROL SOFTWARE MUST BE COMPLETELY 
REINSTALLED. 
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Note 
It is recommended that at least two User Administrators are created 

and that User Administrators be members of a user group  
with no or minimal application rights. 

Rights are assigned to user groups only, not to individual users! 
All users that belong to a particular user group have the rights assigned to that 
user group. 
See 4.1 User Rights for a table of the User Administrator rights and default 
User Group rights. 
The initial password is valid only once! This means that a user has to change the 
password at first login. (This does not apply to the User Administrator). 
Default options for the user administration are as follows: 
• Automatic logout after 15 minutes idle time 
• Exit application (and disable user) after 3 unsuccessful logins 
• Password must contain at least 5 characters 
• Password expires after 90 days 
• The initial password given by the User administrator is only valid for 3 days. 

(Once this time has expired, the User Administrator must reset the 
password.) 

The user administration can be optionally configured to send an email to a 
specified person (administrator or supervisor) when a user is disabled (because 
of too many unsuccessful login attempts, see Email Options).  
To lock the current application, press the key combination Alt-F12. To continue, 
the user has to log in again. 
For more information see 4 User Administration. 
1 See 4 User Administration for differences between User Administrator, 
Hydro_Administrator and System Administrator. 
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2.2 Connect an Instrument 
Up to four instruments can be connected to the software. 

 

CAUTION 
INSTALL THE SOFTWARE BEFORE CONNECTING THE INSTRUMENT 

TO THE COMPUTER. 

Connect the instrument to your computer and switch the instrument on. Start the 
program by selecting Programs/Tecan/HydroControl from the Windows Start 
menu.  

Select Connect from the Instrument menu or click the connect button  and 
the following dialog box appears: 

 
In the Connect to Instrument dialog box select the instrument name.  
Select Show simulated instruments if no instrument is connected. Select the 
instrument to be simulated from the drop down list. 
Click OK to start HydroControl. 
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2.3 Instrument Settings 
The instrument settings can be changed and downloaded to the instrument using 
the HydroControl software.  
Select Settings from the Instrument menu and the following dialog box appears: 

 
The name of the instrument appears in the Name textbox. 
In the Show Messages area, select the checkboxes next to the message(s) to be 
displayed. 
In the Security group box, access to the program and settings menus on the 
instrument can be allowed or denied. Select Program menu access to make 
Define/Edit in the program menu available on the instrument and select Settings 
menu access to make the settings menu available on the instrument. This 
security measure can only be set via the HydroControl software. 
Under Setup the number of channels appears. 
Set the Bubble Sensor sensitivity to Low, Medium, or High depending on 
liquids used (if this option is installed). If very foamy liquids are used the bubble 
sensor should be switched off. 
Under LLD switch on or off the liquid level sensors. 
Select Vacuum Filtration – Low or High Vacuum – to use this option and select 
the Unit of measurement. 
The following vacuum pressure units can be selected: mBar, hPa, torr, inHg, psi 
Select Process Control to use this option and to detect if one or more needles 
are not or too little dispensing/aspirating liquid or if a non-conductive liquid is 
being used. 
Click Open Settings to set the options according to previously saved settings.  
Click Save Settings and enter a name for the file, the extension ‘*.xml’ will 
automatically be added, then click OK.  
Once the settings have been defined, click Update Settings and the settings will 
be sent to the instrument. 
Click Keypad acoustics on/off to adjust the volume of the keypad sounds. 
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2.4 Instrument Options 
Select Options from the Instrument menu to open the Instrument Options 
dialog box, in which the currently installed options can be viewed.  

 
The following options are available for the HYDROFLEX Washer: 
• Vacuum Filtration 
• Magnetic Bead Separation  
• Process Control 
• Liquid Level Detection 

2.4.1 Vacuum Filtration 
Vacuum filtration step is used when working with special filtration microplates 
(e.g. PCR-cleanup). 
The user can select between low (-50 to -150 mBar) and high (-150 to -850 mBar) 
vacuum filtration. 

2.4.2 Process Control 
The instrument can detect if one or more needles are not dispensing/aspirating 
liquid or if a non-conductive liquid is being used. 
Process Control only works with the OVERFLOW wash procedure.  
The wash buffer forms an electrical connection between the dispensing needles 
and the aspirating needles. As soon as the wash liquid touches the aspirating 
needles the electric circuit is closed. 

 

Closed 
circuit 

 
The following errors can be detected using this method: 
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Dispense Error 
An error message appears if some of the needles are dispensing no or too little 
solution. Possible errors could be a result of blocked dispensing needles, bubbles 
in the dispensing channels, empty liquid bottles or the dispensing pump is 
broken. 
If no connection between the dispensing needles and the corresponding 
aspirating needles is made at least 30 µl before the dispensing step is finished, 
the wash program will be interrupted. 

Aspiration Error 
In order to prevent the wells from overflowing, the instrument checks when the 
individual aspiration needles come into contact with the wash solution.  
If this happens before 200 µl have been dispensed into the wells the program is 
stopped immediately and an error message appears. This can occur when the 
well was not or not completely aspirated, due to a blocked aspirating needle/tube 
or the general aspiration being too weak. 

PC Function Error 
Before each wash procedure and each row the program checks whether there is 
an electrical connection between the dispensing and aspirating needle(s). If a 
connection exists, the dispense and aspiration errors cannot be detected and the 
program is interrupted immediately or will not even be started. 
The bottom of the manifold must then be cleaned, as the deposits from the wash 
buffer can produce an electrical connection between the needles, which could 
prevent the Process control option from functioning correctly. 

PC System Error 
Process control is not working. Electronics are defective. 

Requirements for Process Control 
The following conditions are required for the process control to function properly. 
• The conductance of the wash buffer must be between 5 mS/cm and 

30 mS/cm. 
• The wash procedure must be performed in overflow position, so that through 

the simultaneous dispensing and aspiration a closed circuit is formed and a 
min. wash volume of 450 µl. 

Conductance of Some Standard Wash Buffers  
Most of the commercial wash buffers lie in the mentioned conductance ranges. 
The conductance is proportional to the wash buffer concentration. 
The following values were measured using a normal dilution: 

Wash buffer Ortho Diagnostic System: 1:20 - 14.0 mS/cm 

Wash buffer SIGMA: 
Phosphate buffered saline tablets: 1 tablet in 200 ml - 14.7 mS/cm 

Wash buffer bioMérieux: 
Phosphate buffer concentrate: 1:25 - 13.7 mS/cm 

Wash buffer BOUTY: 
Beta IgM: 1:20 - 14.2 mS/cm 

Wash buffer MUREX: 
Wash fluid (Glycine/Borate): 1:20 - 7.8 mS/cm 

Wash buffer BIOTEST ELPHA: 
(Nr. 3 + 4): 1:10 - 28.1 mS/cm 
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2.4.3 Liquid Level Detection (LLD) 
Liquid level sensors are built into the covers of all bottles to avoid overflow of 
waste bottles and to warn the user when the liquid bottles are almost empty. 
 

2.5 Magnetic Bead Separation  
The HYDROFLEX can be equipped with different plate carriers when working 
with magnetic beads. The selection of the plate carrier depends on the type of 
magnetic beads and the plate format used. 
• MBS-96 carrier is used for 96-well microplates. This carrier has strong 

magnets placed exactly under each well. This carrier can be used when 
working with weak magnetic beads or small magnetic beads, such as µ-one 
Dynabeads with approx. 1 µm diameter. 

• Smart 2 MBS-96 carrier is used for 96-well microplates. This carrier uses 
two magnets per well to achieve good bead recovery and low residual 
volume. This carrier is recommended to be used, for example, with Luminex 
magnetic beads for multiplexed assays.  

Recommended plate types 
The magnetic plate carriers were designed to fit the following plate types  
(magnets are as close as possible to the bottom of the wells). 
• 96-well format: Greiner 96-well µ-clear plates with flat bottom wells (Greiner 

article code: 655096) 

 

Note 
Plates which have a raised rim/ring on the underside of the wells may 

create a larger gap between the magnet and the bottom of the well, thus 
causing lower bead recovery and poorer results. 

 

CAUTION 
BE AWARE OF THE PRESENCE OF A MAGNETIC FIELD. 

MAGNETIC FIELDS CAN INTERFERE WITH THE PROPER FUNCTIONING 
OF CARDIAC PACEMAKERS OR SURGICALLY IMPLANTED MEDICAL 

DEVICES. ALL PERSONS ENTERING MAGNETIC FIELD ENVIRONMENTS 
SHOULD BE SCREENED CAREFULLY AND, IF NECESSARY, PROHIBITED 

FROM ACCESS. KEEP ALL MAGNETIC OR FERROUS OBJECTS, 
WATCHES, CREDIT CARDS OR OTHER CARDS WITH MAGNETIC STRIPS 

AWAY FROM INSTRUMENT. 

 

CAUTION 
AVOID TOUCHING THE MBS CARRIERS TOGETHER,  

BECAUSE THIS CAN CAUSE DAMAGE TO THE PLATE CARRIER OR 
CAUSE PERSONAL INJURY. 
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3. General 
3.1 Program Screen Description 

The main window of the HydroControl program is divided into three main parts: 
• The Control pane on the left, which contains program elements 
• The Editor pane in the center contains the current wash program, which 

contains a program strip, a plate strip, and a cycle strip at start up.  
• The Info pane on the right, which contains information about the currently 

selected strip or errors that exist in the strips and information on how to 
prevent these errors.  

 

 
 
The main window consists of the following items which are described in detail in 
the subsequent chapters: 
• Menu bar 
• Tool bar 
• Status bar 
• Control pane 
• Editor pane 
• Info pane 
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3.2 Menu Description 
The HydroControl program has the following menus: 

File Menu 

New Define new programs 

Open Open an existing program 

Save Save the defined program 

Save As... Save the defined program under another name. 
Note: this will create a new audit trail. 

Import Program Import programs 

Print Preview View the print layout before printing 

Print Print the current program and program parameters 

Recent Programs Lists the last 5 programs opened 

Exit Exits the HydroControl software 

View Menu 

Info pane Show or hide the Info pane 

Toolbar Show or hide the Toolbar 

Status bar Show or hide the Status bar 

Audit trail Opens the Audit Trail dialog box, in which the audit trail can be viewed, 
printed, and saved. 

Signature Opens the Signature dialog box, in which the signatures can be viewed and a 
new signature can be added 

Collapse all Collapse all strips 

Expand all Expand all strips 

Instrument Menu 

Connect Opens the Connect to Instrument dialog box, in which the instrument can be 
connected to the computer. 

Disconnect Disconnects the instrument from the computer 

Prime Opens the Prime dialog box, in which the prime parameters can be selected 
and the prime procedure can be started 

Rinse Opens the Rinse dialog box, in which the rinse parameters can be selected 
and the rinse procedure can be started. 

Empty Prime Tub  Empties the prime tub  

Clean Vacuum Chamber A special procedure for cleaning the vacuum filtration carrier 
See chapter Clean Vacuum Chamber for more details on cleaning the 
vaccum chamber seperately. 

Stacker Control Stacker Control is not available with the HYDROFLEX. 

Vacuum Filtration To prepare vacuum to the required level. 
The program will not be delayed during a run (if this option is installed). 

Settings Opens the Settings dialog box, in which instrument parameters can be 
viewed. Settings can be saved, opened, and downloaded to the instrument 
(update). Instrument Menu security can be defined. Bubble sensor 
parameters can be set. Reminder messages can be switched on or off.  
LLD (Liquid Level Detection), Vacuum Filtration and Process Control can be 
switched on or off.  
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Options Opens the Options dialog box, in which the current instrument options can be 
viewed. 

Program / List Menu 

Start program from 
instrument 

Opens the Start Program from Instrument dialog box, in which a program can 
be selected from the Installed Programs list, a plate range can be defined and 
the program can be started.  

Start program from editor Opens the Select Plate Range dialog box, in which a plate range can be 
defined and the program currently open in the Editor pane can be started.  

Manage Programs Opens the Manage Programs dialog box, in which the currently installed 
programs can be viewed. Programs can be saved and downloaded to the 
instrument, uploaded from the instrument, deleted, or locked. 

Manage Lists Opens the Manage Lists dialog box, in which the currently saved lists can be 
viewed. Lists can be created, edited, printed, imported, displayed, or 
downloaded to the instrument. The audit trail of the list can be viewed and 
signatures can be viewed and new signatures can be added. 

Plate Menu 

Manage Plates Opens the Manage Plates dialog box, in which the currently defined plates 
can be viewed. Plates (plate definition files) can be downloaded to the 
instrument, uploaded from the instrument, deleted, edited, created, or locked. 

Tools Menu 

Select Language Choose the appropriate language for the software and the instrument. 

Change User Change user by entering new user name and password. 

User Administration Users and groups can be added, edited or disabled and user rights can be 
defined. 

Options 
Auto Login 

Select Auto Login if the user wants to start HydroControl software without 
entering username and password. 

Help Menu  

Contents Opens the Contents view of the Help file for the HydroControl software 

Index Opens the Index function of the Help file for the HydroControl software 

Search Opens the Search function of the Help file for the HydroControl software 

About Lists the version numbers of the components of the currently installed 
HydroControl program 
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3.3 Toolbar Description 
The program has the following toolbar: 

 
 

Button Explanation 

 
Opens a new program (with no defined steps) 

 
Opens an existing program 

 
Saves an existing program 

 

Prints information about the instrument, software, and the program 
currently defined in the Editor pane using the default printer.  
This includes General information such as the HydroControl 
software version number and Instrument Serial Number, Audit trail 
comments, List of Signatures, Program Parameters, and Plate 
Parameters.  
See 3.13 Printing Programs  for a sample printout. 

 
Expands all program strips 

 
Collapses all program strips 

 /  
Connects instrument / Disconnects instrument 

 
Starts the program currently open in the Editor pane 

 
Opens the Prime dialog box 

 
Opens the Rinse dialog box 

 
Opens the Help file 
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3.4 Status Bar Description 
The status bar provides the Instrument Name, Instrument Serial Number, 
Instrument Mode, and the Sensor Status and the current vacuum pressure. 
 

 
 

3.4.1 Sensor Status 
The sensor status is only active if the LLD option (Liquid Level Detection) or the 
Vacuum Filtration option is installed and the sensors are activated  
(see 2.3 Instrument Settings). The “lights” appear gray if the option is not 
installed. 
LLD Option:  
Liquids 1-4 
• light is green when the bottle is full 
• light is red when the bottle is empty 
Waste 1 and Vacuum waste 
• light is green when the bottle is empty  
• light is red when the bottle is full 
Vacuum Filtration Option: 
• light is green when vacuum pressure has reached the user-defined level 
• light is red when vacuum pressure has not reached the user-defined level 
• the current vacuum pressure appears to the right of the light 
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3.5 Creating and Editing Programs 
To define a new program, either click the New button  or select New from the 
File menu. The main window appears as follows: 

 
By default a program strip, plate strip, and a cycle strip appear in the Editor pane 
when a new program is created. 
The Control pane contains all of the available elements, which can be inserted 
into a program in the Editor pane and is divided in three groups: Lab Ware, 
Program Items, and Options (See also 3.1 Program Screen Description). 

3.5.1 Program Strip 
By default a program strip appears in the Editor pane when a new program is 
created. A program must contain a program strip and only one program strip is 
allowed per program. The program strip must be the first element in a 
program. 

 
Enter a Program name in the text field and select the wash mode: 

Plate Mode Each program step is performed on all of the plate strips of a 
microplate sequentially, before proceeding to the next step. 
The entire plate is processed for the defined soaking time. 

Strip Mode The entire wash program is performed on one plate strip (8-
way manifold) or two consecutive plate strips (16-way 
manifold) before proceeding to the next plate strip(s). The 
plate strip(s) is processed for the defined soaking time, 
before proceeding to the next plate strip(s). 
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Add Final Aspirate  
The final aspirate step is inserted to empty the wells at the end of a wash 
program. It does not belong to any cycle and is only performed once. 

 
Select the Mode: Normal or Crosswise. 
Select the Z-position: Bottom, Overflow or Custom. 
Select the Time to determine how long the aspiration needles stay at the bottom 
position while the reagent is being aspirated, (1 - 20 seconds).  
Select the Head speed to determine how fast the needles move into the well, 
(1 - 20 mm/s). 
Select the Aspiration rate (1 - 3). 
See 3.5.4 Aspirate Step for detailed information. 

3.5.2 Plate Strip 
By default a plate strip appears in the Editor pane when a new program is 
created. A program must contain a plate strip and only one plate strip is allowed 
per program. The Plate strip must be placed after the Program strip. 

 
Select the plate type from the Plate definition drop-down list. Click the Details 
button to view the plate parameters of the selected plate type. 
See 3.15 Editing Plate Parameters for details about defining custom plate types. 

3.5.3 Program Cycles  
By default a cycle strip appears in the Editor pane when a new program is 
created.  

To insert a cycle strip, select the cycle icon  from the Control pane 
and drag it to the desired position in the Editor pane and release it. Or double-
click the item to place it at the end of the program. The first Cycle strip must be 
placed after the Plate strip, however more than one cycle strip is allowed in a 
program. 
A cycle consists of a number of program steps that are processed sequentially. 
The entire cycle can be repeated up to 9 times.  

 
In the Number of cycles text box, select the number of times the cycle is to be 
repeated (1 - 9 times). Cycles cannot be nested, i.e. a cycle cannot contain 
another cycle.  
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3.5.4 Aspirate Step  
An aspirate step removes liquid from the wells.   

To insert an aspirate step, select the aspirate step icon  from the 
Control pane and drag it to the desired position in the program window and 
release it. Or double-click the item to place it at the end of the program. 

 
Select the aspirating Mode: Normal or Crosswise (see Aspirating Mode below 
for a detailed description). 
Select the Z-position: Bottom, Overflow or Custom. 
Overflow Position: 
The aspirating needle is positioned slightly above the rim of the well in 
accordance with the defined plate type (*.pdfx file).  
Bottom Position: 
The aspirating needle is set at the deepest position inside the well in accordance 
with the defined plate type (*.pdfx file). 
Custom Position: 
The aspirating needle is positioned at a user-defined distance. When Custom is 
selected, the dispensing will be performed at this user-defined Z-position. Custom 
Z-positions cannot be saved in the plate definition (*.pdfx file). 
In the Time area, select how long the aspiration needles stay at the bottom 
position while the reagent is being aspirated, (1 - 20 seconds).  
In the Head speed area, select how fast the needles move into the well 
(1 - 20 mm/s).  
Select an Aspiration rate from the drop-down list (1 - 3).  

Aspirating Modes 
To improve wash efficiency and to reduce the residual volume, the manifold must 
be positioned so that the aspirating needles are correctly positioned in the wells 
for round-bottom, v-shaped bottom, or flat-bottom well microplates. 

Normal Aspiration Mode 
For round-bottom or v-shaped bottom wells, the aspirating needles are placed in 
the middle of the wells. Only one aspiration position can be selected. 
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Fig. Aspirating Positions 

 

Crosswise Aspiration Mode 
With flat bottom wells, the instrument can perform crosswise aspiration.  
The aspirating needles are set at two positions on the bottom of the wells  
(front edge and back edge). 

 
Fig. Crosswise Aspiration for Flat Bottom Wells 

3.5.5 Dispense Step 
A dispense step fills the wells with liquid.  

To insert a dispense step, select the dispense step icon  from the 
Control pane and drag it to the desired position in the program window and 
release it. Or double-click the item to place it at the end of the program. 

 
Select the Z-position: Bottom, Overflow or Custom. 
Overflow Position: 
The aspirating needle is positioned slightly above the rim of the well in 
accordance with the defined plate type (*.pdfx file).  
Bottom Position: 
The aspirating needle is set at the deepest position inside the well in accordance 
with the defined plate type (*.pdfx file). 
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Custom Position: 
The aspirating needle is positioned at a user-defined distance.  
When Custom is selected, the dispensing will be performed at this user-defined 
Z-position. Custom Z-positions cannot be saved in the plate definition (*.pdfx file). 
When z-position Custom or Overflow is selected, the Move button becomes 
available. Move is not available for z-position Bottom. Recommended for cell and 
MBS applications. 

 
Fig. Diagrams of wash head z-positions 

In the Volume area, select the volume of liquid to be dispensed 
(50 - 400 µl in steps of 10 µl). 
In the Channel area, select which channel is to be used, (1 - 4) depending on the 
instrument configuration and settings. 
Select the Dispense rate: Drip Mode, 200, 250, 300, 400, or 500 µl/s 

3.5.6 Wash Step  
Liquid is dispensed and aspirated simultaneously creating a circular flow with a 
maximum volume of 3000 µl in one wash step for increased wash efficiency.  

To insert a wash step, select the wash step icon  from the list of 
available Program Items, drag it to the desired position in the program window 
and release it. Or double-click the item to place it at the end of the program. 

 
Select the aspirating Mode: Normal or Crosswise (see chapter 3.5.4 Aspirate 
Step). 
Select the Z-position: Bottom, Overflow or Custom. 
Overflow Position: 
The aspirating needle is positioned slightly above the rim of the well in 
accordance with the defined plate type (*.pdfx file).  
Bottom Position: 
The aspirating needle is set at the deepest position inside the well in accordance 
with the defined plate type (*.pdfx file). 
Custom Position: 
The aspirating needle is positioned at a user-defined distance.  

 

Bottom Z-Position 
Custom Z-Position Overflow Z-Position 
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When Custom is selected, the wash step will be performed at this user-defined 
Z-position. Custom Z-positions cannot be saved in the plate definition (*.pdfx file). 
When z-position Custom or Overflow is selected, the Move button becomes 
available. Move is not available for z-position Bottom. Recommended for cell and 
MBS applications. 
 

Bottom Z-Position 
Custom Z-Position Overflow Z-Position 

 
Fig. Diagrams of wash head z-positions 

In the Volume area, select the volume of reagent to be dispensed: 50 - 3000 µl in 
steps of 50 µl. 
In the Channel area, select which reagent is to be dispensed, (1 - 4) depending 
on instrument configuration. 
In the Head speed area select the speed (how fast the needles move down: 
1 - 20 mm/s). 
Select the Wash rate: Drip Mode, 200, 250, 300, 400, or 500 µl/s 
Select an Aspiration rate from the drop-down list (1 - 3).  
In the Aspiration time area, select how long the aspiration needles stay at the 
bottom position while the reagent is being aspirated, (1 - 20 seconds).  

3.5.7 Soak Step  
During a soak step the liquid remains in the wells for the set time (with or without 
shaking). 

To insert a soak step, select the soak step  from the Control pane, 
drag it to the desired position in the program window and release it. Or double-
click the item to place it at the end of the program. 

 
In the Time area enter the required soaking time  
(0 – 60 min and 0 – 59 seconds). 

 

Note 
If the soak time is very short, select strip mode to ensure that the soak 

time is the same across the plate. 

If the plate is to be shaken, select Shake and the required Intensity (Low, 
Medium, or High).  
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3.5.8 User Prompt Step 
The User Prompt program element informs the operator of the instrument at a 
certain moment to execute a definite action during the workflow. Up to 16 
characters can be used. 

 
To continue, the operator of the instrument has to press the OK button on the 
display. Please be aware that the command cannot be executed within the 
software. 

3.5.9 Vacuum Filtration Step 
Vacuum filtration step is used when working with special filtration microplates 
(e.g. PCR-cleanup). This option requires the Tecan Vacuum Filtration 
Station.  
To perform a high vacuum filtration step observe the following order of actions: 
Enable Vacuum Filtration in the settings menu (see chapter 2.3 Instrument 
Settings). Then select Vacuum Filtration in the instrument menu to prepare the 
required vacuum pressure (vacuum range: -150 mBar to -850 mBar). 

 
Select the appropriate Pressure and click Start to build up the vacuum pressure 
for vacuum filtration. 

 

Note 
Prepare Vacuum: the value in the Prepare Vacuum dialog and the value 
of the vacuum strip should be identical in order to guarantee enough 

time for filtration. 

To insert a vacuum filtration step, select the vacuum filtration step icon 

 from the control pane, drag it to the desired position in the 
program window and release it. Or double-click the item to place it at the end of 
the program. When Vacuum Filtration is activated, aspiration cannot be selected. 

 
Select the length of Time the vacuum filtration should be performed:  
0-60 min and 0-59 seconds 
Select the Vacuum pressure; see 2.3 Instrument Settings for selecting the unit of 
measurement. 
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The selectable vacuum range is: 
for Option Low Vacuum:   between -50 mBar to -150 mBar 
for Option High Vacuum:  between -150 mBar to -850 mBar 
If your instrument is equipped with the Low Vacuum option, no Vacuum Prepare 
procedure is necessary. 
Select Clean to remove droplets from the bottom of the filtration plate and to 
remove excess liquid from the plate transport during a filtration procedure. 
If more than 100 µl are filtrated during a vacuum filtration step, we highly 
recommend to select the Clean command. 

Clean Vacuum Chamber 
This procedure is used to thoroughly clean the plate carrier after running a wash 
program that contains a vacuum filtration step.  
Select Clean Vacuum Chamber from the Instrument menu to start the vacuum 
chamber rinsing procedure.  
The following dialog box appears: 

 
Click Start and a message appears requesting that the microplate be removed 
from the chamber: 

 
Remove the microplate and click OK to start the rinsing procedure. 
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3.6 Sample Programs 
The following shows a typical wash procedure for working with cells. 

 
 

 

Note 
This example should not be used as a standard wash procedure for cells 
as it is necessary to adjust all settings according to the cell type used. 
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The following shows a typical wash procedure for an ELISA assay. 

 
 

 

Note 
This example should not be used as a standard wash procedure for 

processing ELISA assays as it is necessary to adjust all settings 
according to the cell type used. 
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The following shows a typical wash procedure for vacuum filtration: 

 
 

 

Note 
This example should not be used as a standard wash procedure for 

vacuum filtration as it is necessary to adjust all settings according to the 
cell type used. 
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3.7 Saving a Program 
When all the required steps have been defined, save the program by clicking the 

Save button  or by selecting Save from the File menu.  
The Save Program dialog box appears: 

 
Enter the required name for the file in the Document name field; the extension 
*.hcp will be added automatically.  
For additional security, a password can be entered optionally when saving a 
program. The password is not mandatory. 
There are three scenarios: 
• No password 
• Programs can be locked without entering a password in the Manage 

Programs menu. 
• The program can be protected by entering a password (5 - 7 characters) 

when it is saved. 
Click Save and – if a password has been entered – the Password dialog box 
appears again requesting that the password be re-entered. Enter the password 
again and click OK. Password-protected programs will appear after download as 
shown in the following screenshot in the Manage Programs dialog box: 
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Every time the program is manipulated, e.g. opened, uploaded, saved etc., the 
password (5 - 7 characters) has to be re-entered. 

 
Click Save and the Save File dialog box appears. 
Enter any Remarks or Audit Trail Comments in the corresponding text boxes 
and then click OK to save program. 
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The same name cannot be used more than once: 

 
Once the file has been saved, the following reminder appears: 

 
It is important to download the program to the instrument, so that the program 
can be started from the instrument display (see 3.11 Running a Program). The 
program can also be started directly from the Editor without being downloaded. 
Click OK to return to the main window. 

3.7.1 Locking Programs 
For security purposes, a wash program can be locked, so that only users with 
enough rights can open them. 
Select a wash program from the list of Currently Installed Programs and click 

Lock  to lock the program. 
Locked programs will appear as follows in the Defined Programs list of the 
Manage Programs dialog box: 

 
For additional security, the program can also be password-protected (5 - 7 
characters). 
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3.8 Importing Programs 
Programs can be imported as files to allow the exchange of documents (e.g. send 
a program via email) between instruments. Programs can only be imported using 
HydroControl software.  
To import a program, select Import Program from the File menu. The Import 
Program dialog box appears: 

 
After selecting the program file, click Open and the program appears in the Editor 
pane.  
If a program is already open in the Editor pane, a message will appear asking if 
you would like to save the open program. Save or discard the program by clicking 
Yes or No. 

3.9 Opening a Program 
In the File menu, click Open… or on the toolbar, click the Open button  to 
open an existing program. The Open Program dialog box appears: 

 
A list of existing files, which includes the Filename and any associated Remarks 
for each program, is shown.  
Select a program and click Open. The selected program will appear in the Editor 
pane. The file name of the opened program is displayed in the Main window title. 
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3.10 Transferring Programs to and from the 
Instrument 

Before starting either of the following procedures, ensure that the instrument is 
switched on and is connected to the computer using a suitable connection cable.  

3.10.1 Downloading a Program to the Instrument  
To download the program currently in the Editor pane to the connected washer, 
select Manage Programs from the Program/List menu. The Manage Programs 
dialog box appears: 

 
Select a program position in the list of Currently Installed Programs to which 
you would like to download the program currently open in the Editor pane.  

Click the Download icon  or the 

Save and Download  icon under Instrument on the left 
side of the dialog box. The name of the program will appear in the list at the 
selected position. 
If a program already exists in this position a warning message appears:  

 
Click Yes to overwrite the program on the instrument. 
A message appears confirming the download:  
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3.10.2 Upload Program from the Instrument  
To upload a program from the instrument, select Manage Programs from the 
Program/List menu. The Manage Programs dialog box appears: 

 
Select the program to be uploaded from the list of Currently Installed Programs 

and click the Upload icon  under Instrument on the left side of the 
dialog box. The program will appear in the Editor pane. 
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3.11 Running a Program 

 

Note 
Always perform a priming step before starting a program. 

 

CAUTION 
TO AVOID SPILLS WHEN USING STRIP-WELL PLATES, CHECK THAT 

THE SELECTED NUMBER AND POSITION OF THE STRIP 
CORRESPONDS TO THE MANIFOLD INSTALLED ON THE HYDROFLEX 
WASHER AS WELL AS TO THE LAYOUT OF THE STRIP PLATE TO BE 

WASHED. FOR DETAILS, SEE THE INSTRUCTIONS FOR USE FOR 
HYDROFLEX WASHER. 

 

CAUTION 
BEFORE WASHING PROCEDURES ARE STARTED, MAKE SURE THAT 

THE MICROPLATE  
POSITION A1 IS INSERTED CORRECTLY.  

A program can be started either from the instrument or from the editor. 
To start a program from the instrument, select Start Program from the 
Instrument from the Program/List menu and the following dialog box appears: 

 
Select the program from the list of Installed Programs. 
Select the Plate Range: 

Whole Plate: all strips are selected automatically 

Strips: select the group of strips to be processed  
from the drop-down list (always begins with strip 1 
(8-way manifold) or strips 1/2 (16-way manifold) 

Mask: select the individual strips to be processed 
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Click Start to start the program. The Program Status dialog box appears 
(see Program Status, below).  
The selected plate range of the last started program is remembered.  
To start a program from the Editor, select Start Program from the Editor from 
the Program/List menu or click the Start Program from the Editor button 

 and the following dialog box appears: 

 
Select the Plate Range: 

Whole Plate: all strips are selected automatically 

Strips: select the group of strips to be processed  
from the drop-down list (always begins with strip 1 
(8-way manifold) or strips 1/2 (16-way manifold) 

Mask: select the individual strips to be processed 

Click Start to start the program. The Program Status dialog box appears 
(see Program Status, below).  

Program Status 
When Start is clicked, the Program Status dialog box appears: 

 
The Start time and the Current action will be shown while the program is 
running. 
To abort the program, click Stop. When the program has ended, the End time will 
be shown. Click Close to return to the main window. 
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3.12 Viewing and Signing Programs  
To view the signatures or to add a signature to the program currently open in the 
Editor pane, select Signature from the View menu. The following dialog box 
appears: 

 
A list of all signatures is displayed.   

3.12.1 Signing Documents 
Select Add signature to sign the program and the following dialog box appears: 

 
The name of the program is displayed in the Document Name group box. 
In the Meaning group box, the following options are available for the Meaning of 
the signature. 

Review Can be used as part of a release process; program or program 
list has been checked for errors and is ready for approval. 

Approval Can be used as part of a release process; program or program 
list has been tested and is approved for use. The approval 
signature can only be applied if a review signature has already 
been applied to the record. The Review signature and the 
Approval signature cannot be signed by the same user. 

Any necessary comments can be added in the Comment text box. 
In the User Information group box, the user name of the currently logged in user 
is displayed. In the Password text field, the password of the currently logged in 
user must be entered to complete the signing procedure. 
Click OK to confirm the entries and sign the document. 

 

Note 
Depending on the standard operating procedures of the company using 

this software, this signature may be viewed as legally binding, therefore it 
is very important that the users keep the passwords secret. 
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3.12.2 Program Audit Trail 
To view the audit trail of the program currently open in the Editor pane, select 
Audit Trail… from the View menu.  

 
Whenever a file is created or changed, a record of this action is saved in the 
Audit Trail. Traceability of changes is provided in connection to the user name 
(User Full Name). 
All modifications to the document are shown and listed according to its version 
number. Each audit trail entry contains the Version number, User Full Name, 
User ID, Date of modification, Action (created, modified, or signed) and the audit 
trail Comment (if entered). 
Click Print version to view a report of all relevant data for the audit trail. 
Click Save as to open the Save Program dialog box, (see 
3.7 Saving a Program). A previous version of the program currently open in the 
Editor pane can be saved using a different file name. A new audit trail will be 
created for this program. 

3.13 Printing Programs 
3.13.1 Print 

To print the parameters of the active program, click the Print button  or select 
Print from the File menu. The program parameters will be printed according to 
the settings made in the Print dialog box. The WindowsTM Print dialog box 
appears: 

 
Adjust the settings as desired and click Print.  
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3.13.2 Print Preview 
To check the document before printing, select Print Preview from the File menu 
to display the Report window: 
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Print Preview Toolbar 
The Report window has the following toolbar: 

 
Button Description 

 
By clicking the Print button, the WindowsTM Print dialog box 
appears. Adjust the settings as desired and click Print.  

 View the first page of the report. 

 View the previous page of the report. 

 View the next page of the report. 

 View the last page of the report. 

 By clicking the Go to Page button, the Go to Page dialog box 
appears: 

 
Enter the number of the page to be viewed and click OK. 

 

 

 By clicking the arrow of the Zoom button, the Zoom menu drops 
down: 

 

 
Select Page Width, Whole Page, one of the 
displayed zoom percentages or click 
Customize... to open the Zooming dialog box 
in which a custom zoom percentage can be 
entered: 
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3.14 List Management 
Select Manage Lists from the Program/List menu and the following window 
appears: 

 
A list is a group of wash programs and plates, which can all be downloaded to the 
instrument simultaneously.  
Defined lists, including the Filename and any associated Remarks for each list, 
are displayed. 
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3.14.1 Creating and Editing Lists 
 

 

Note 
The wash head of the program must be identical to the currently installed 

wash head of the instrument. 

To define a new list of programs or to edit an existing list of programs, select 
Manage Lists from the Program/List menu and the Manage Lists window 
appears (see 3.14 List Management above). 

Click Create new list  to make a new list,  

or click Edit list  to modify an existing list and the following dialog 
box appears:  

 
A list can contain up to 20 programs. 

By pressing the Add program to list  button in the middle of the window, 
selected program(s) are transferred from the left window (programs currently 
installed on the instrument) to the right window (programs in the list). 

Alternatively, press the Add all programs to list  button to transfer all 
available programs to the list. Empty positions in the Currently Installed 
Programs (left) window will not overwrite occupied positions in the Programs in 
List (right) window. 
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Use the Remove program from list  button to delete selected programs 
from the list (left window only). This will NOT delete any programs from the 
instrument! 

Use the Add saved program to list  button to import a list of programs. 

Use the Move program up  and Move program down  buttons to the 
right of the right window to move the position of the selected program up or down 
in the list. 
When a list is downloaded to the instrument and it contains empty program 
positions, the corresponding programs on the washer are not deleted! (I.e. If a list 
contains only programs on storage places 1 and 3, all other programs in positions 
2 and 4 through 20 on the instrument will not be overwritten when the list is 
downloaded). 
To link programs to plates, switch between the tabs Washer Programs and 
Washer Plates. 

3.14.2 Saving Lists 
When the list of programs is complete, it can be saved by clicking Save or click 
Save as to save a modified list under a different name. The Save List dialog box 
appears: 

 
Enter a Document name and click Save. The extension *.hcl will automatically 
added to the file name. The Save File dialog box appears: 
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Enter any Remarks or Audit Trail Comments in the corresponding text boxes 
and then click OK to save the list.  

3.14.3 Printing Lists  

Click Print list  to open the Report window, in which the printout 
can be viewed before printing. See 3.13.2 Print Preview for a detailed description 
of the Report window. 

3.14.4 Importing Lists  
Previously defined lists can be opened from file to allow the exchange of 
documents (e.g. send a list via email) between instruments. Lists can only be 

imported using the HydroControl software. Click Import list  to 
open the Import List dialog box in which a list file (*.hcl) can be browsed for and 
opened. 

3.14.5 Viewing Lists  

Click Show list  opens the Manage List Programs dialog box, in 
which the selected list can be viewed, but not modified. 

3.14.6 Downloading Lists to the Instrument  

Click Download list  from Manage Lists dialog box to 
download a list of programs to instrument. 
A warning will appear if program positions in the list are already occupied on the 
washer: 

 
Click Yes to replace the programs. 
A reminder appears which lists plate types required by the programs, but are not 
installed: 

 
Click Yes and the Manage Plates dialog box opens, in which the required plate 
types can be selected for downloading. 
A message appears which confirms the successful download of the list to the 
washer: List of programs successfully downloaded. Click OK to return to the 
main window. 

  



 3.  General 

2017-12 HydroControl No. 30064355 Rev. No. 2.5 53 

3.14.7 Audit Trail of Lists  

Click Audit trail  to view the audit trail of the list. the following 
dialog box appears: 

 
Click Print version to open the Report window, in which the printout can be 
viewed before printing. See 3.13.2 Print Preview for a detailed description of the 
Report window. 
Click Save as to save a previous version of the selected list using a different file 
name. A new audit trail will be created for this list. 

3.14.8 Signing Lists  

Click Signature  to sign the selected list. See 3.12.1 Signing 
Documents for a detailed description of signing documents. 
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3.15 Editing Plate Parameters 
The HydroControl software contains the parameters of many commonly used 
microplates. Some of the parameters of these plates can be modified to adapt 
them to specific needs or a completely new set of parameters can be defined for 
microplates that are not available in the software.  
The instrument can store up to 20 plate definitions, making it easy to run 
programs which require various types of microplates or the same microplate type 
with different parameters depending on the tests performed. 

 

WARNING 

ADJUSTMENT OF HYDROFLEX WASHER TO A CORRESPONDING 
MICROPLATE: 

TO ENSURE PROPER WASH PERFORMANCE IT IS MANDATORY TO 
ADJUST THE HYDROFLEX WASHER TO THE TYPE / 

MANUFACTURER OF MICROPLATE OR STRIP-PLATE USED. 
THIS ALSO APPLIES FOR ANY PRE-DEFINED PLATE FILE, THAT 
WILL ALWAYS CONTAIN AVERAGE PLATE PARAMETERS ONLY, 
THAT HAVE TO BE VERIFIED WITH THE CORRESPONDING PLATE 
TYPE AND IF NECESSARY CORRECTED BEFORE PUTTING THE 

HYDROFLEX WASHER INTO USE.  
IF THIS ADJUSTMENT PROCEDURE IS NOT PERFORMED 

PROPERLY, THIS MIGHT RESULT IN HIGH LEVELS OF RESIDUAL 
VOLUME LEFT PER WELL, AS WELL AS IN INSUFFICIENT WASHING 

OF THE WELLS AND MAY SERIOUSLY AFFECT ASSAY 
PERFORMANCE. 

FOR DETAILS ON HOW TO ADJUST THE HYDROFLEX WASHER TO 
THE TYPE OF MICROPLATE OR STRIP-PLATE USED, SEE THE 
INSTRUCTIONS FOR USE FOR THE HYDROFLEX PLATFORM. 

 

CAUTION 
BE CAREFUL WHEN USING STRIP-PLATES THAT ALL STRIPS ARE 
INSERTED AND POSITIONED CORRECTLY, OTHERWISE SPILLING  

CAN OCCUR AND THE INSTRUMENT MAY BECOME CONTAMINATED. 

 

Note 
When plate parameter settings are changed on the instrument using the 

display, do not forget to save them (upload the .pdfx file) to the 
HydroControl software via Plate menu / Manage Plate. 

 

Note 
When plate definition files with the same name are stored on the 

instrument and in the software, the HydroControl uses the version 
saved in the software (.pdfx). 
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Select Manage Plates from the Plates menu and the following dialog box 
appears: 

 
To adjust the parameters of an existing plate type, select the plate from the list of 
Defined Plates or to define parameters for a new microplate type, select an 
empty position in the list of Defined Plates and click Edit. 
The Edit Plate Definition dialog box appears: 

 
Select Choose a plate file to modify the parameters of an already defined 
microplate or select Create a new plate file to define parameters for a new 
microplate type.  

General Tab 
For new microplates, it is possible to define the Description parameters for the 
plate on the General tab: Manufacturer, Color, Material, and a Comment can 
be added for easy identification.  

 

Note 
For the HYDROFLEX Washer, do not change the number of rows and 

columns (8 rows, 12 columns). 
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Plate Geometry Tab 
When defining new plate types, enter parameters as shown below. 

 
The plate geometry can be defined according to Size and Height. 
Plate Size Parameters 

Length Enter the length of the microplate in µm (including the 
skirt) 

Width Enter the width of the microplate in µm (including the skirt) 

Left well position X-value of A1 distance to middle of well 

Right well position X-value of H12 distance to middle of well 

Upper well 
position 

Y-value of A1 distance to middle of well 

Lower well 
position 

Y-value of H12 distance to middle of well 

 
Plate Height Parameters 

Plate height Enter the height of the microplate in µm (including the 
skirt) 

Height tolerance Enter the tolerance of the height measurement distance 
from upper surface of plate 

Height with cover Enter the height, in µm, of the microplate with a cover on 
(including the skirt) 

Skirt height Enter the skirt height 
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Well Geometry Tab 
When defining new plate types, enter parameters as shown below. 

 
On the Well Geometry tab, the form and size of the wells can be defined: 

Well form top Select the shape of the top of the wells: Rectangle, Round, 
Square, or Unknown. 

Well diameter Enter the Length and Width of the wells for rectangular and 
square wells or the Diameter for round wells (in µm). 

Well depth Enter the depth of the wells in µl.  

Bottom form Select the shape of the bottom of the wells: Flat, Round, V-
shaped, or Unknown. 

Working volume Enter the working volume of the wells in µl. 

Max volume Enter the maximum volume of the wells in µl. 

 

 

Note 
Information about the well and plate geometry  

is available from the manufacturer. 
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Plate Parameters Tab 
When defining new plate types, enter the default values of the Greiner 96-well 
flat-bottom transparent microplate, if any values are set to zero. 

 
On the Plate Parameters tab, the aspiration offsets, dispensing offset, and 
Z-positions can be defined. 

Aspirate Y Offset 1 The position of the aspiration needles in which 
aspiration is started 

Aspirate Y Offset 2 The position of the aspiration needles in which 
aspiration is finished (Only selectable for 96-well flat-
bottom plates) 

Dispense Y Offset The position of the dispensing needles in which 
dispensing occurs (restricted by length of aspirating 
needles) 

Z Position Bottom The position of the aspiration needles in which bottom 
washing occurs 

Z Position Overflow The position of the aspiration needles in which overflow 
washing occurs 

Click Adjust and the wash head moves to the defined position. 
When changing the offsets, the user  has to confirm the new values by pressing 
OK on the instrument’s display. 
Select whether these positions will be determined according to the First strip or 
Last strip. 
Plate settings edited on the instrument’s display are saved to the instrument. 
When working with the HydroControl Software the edited plate file (*.pdfx) must 
be saved to the computer, otherwise the plate settings on instrument and 
computer may be different.  
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Note 
Adjust parameters of a filter plate used for vacuum filtration only when 
vacuum filtration is enabled in the settings menu of the instrument and 

the standard tray is installed. 

 

Note 
Make sure that the vacuum transport is mounted when the vacuum 

filtration option is enabled. 

3.15.1 Needle Position Diagrams 
Define wash positions as shown in the diagrams below. 

Aspiration Positions 
 Aspirate Y Offset 1 Aspirate Y Offset 2 

Front position Back position 
 

Aspirate Y Offset Positions 

Dispense Position 

 
Dispense Y Offset Position 

Z-Positions 

 

 
 

Z-Position Bottom 

Z-Position Overflow 

 
Z-Positions 
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3.15.2 Saving Plate Parameters 
Click Save as and enter a name for the newly defined plate parameters. Give the 
plate definition file a descriptive name (e.g. “Greiner1”). The extension *.pdxf 
will automatically be added to the file name. 

 
The plate parameters can now be used when defining a program, by selecting the 
necessary plate type from the Plate definition drop-down list of the Plate strip, 
(see 3.5.2 Plate Strip for more information). 

 

Note 
When plate parameter settings are changed on the instrument using the 

display, do not forget to save them (upload the .pdfx file) to the 
HydroControl software via Plate menu / Manage Plate. 

3.15.3 Locking Plates 
For additional security, a password can be entered optionally when saving a plate 
definition. The password is not mandatory. 
There are three scenarios: 
• No password 
• Plate definitions can be locked without entering a password in the Manage 

Plates menu. 
• The plate can be protected by entering a password (5 - 7 characters) in the 

Manage Plates dialogue. 

Select a plate from the list of Defined Plates and click Lock  to 
password-protect (5 - 7 characters) the plate definition file. 
The Password dialog box appears: 
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Regular Security (Lock) 
For regular security, do not enter a password and click OK. Only users with 
enough rights can open plates locked in this way. Locked plates will appear as 
follows in the Defined Plates list of the Manage Plates dialog box: 

 
High Security (Password, OEM Lock)  
For higher security, enter a password (5 - 7 characters) and click OK and the 
Password dialog box appears again requesting that the password be reentered. 
Enter the password again and click OK.  

 
Password-protected plates will appear as follows in the Defined Plates list of the 
Manage Plates dialog box:  
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3.15.4 Downloading Plate Definition Files 
To download plate definition files to the instrument, select Manage Plates from 
the Plate menu and the following dialog box appears: 

 
Select an empty position or choose to overwrite a filled position and click 
Download. The following dialog box appears: 

 
Select a plate from the drop-down list and click OK. The plate definition file will 
be downloaded to the instrument and the following message appears to confirm 
the successful download. 

 
 

 

Note 
When plate parameter settings are changed on the instrument using the 

display, do not forget to save them (upload the .pdfx file) to the 
HydroControl software via Plate menu / Manage Plate. 
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3.16 Priming 

 

WARNING 

BEFORE THE INSTRUMENT CAN BE USED, ALL DISPENSING 
CHANNELS NEEDED FOR THE WASH STEP MUST BE PRIMED TO 

FILL THE DISPENSE SYSTEM WITH THE REQUIRED LIQUID. 

IF THE PRIMING PROCEDURE IS NOT PROPERLY PERFORMED, THIS 
MAY RESULT IN INSUFFICIENT WASHING OF THE WELLS AND MAY 

SERIOUSLY AFFECT ASSAY PERFORMANCE. 

ENSURE THAT THE BOTTLE OF PRIMING SOLUTION IS ALWAYS 
FULL AT THE BEGINNING OF THE PRIMING PROCEDURE AND 
CHECK THAT THE INLET FILTERS IN THE LIQUID TUBES ARE 

CLEAR. 

 

CAUTION 
ENSURE THAT THE DISPENSING AND ASPIRATION PUMPS ARE NOT 
RUN FOR LONGER THAN A FEW MINUTES WITHOUT LIQUID OR THEY 

WILL BE DAMAGED. 

 

CAUTION 
DO NOT USE THE INSTRUMENT TO ASPIRATE OR DISPENSE ANY 
ACIDIC SOLUTIONS AS THIS COULD DAMAGE THE INSTRUMENT.  

 

 
 

WARNING 

WASTE BOTTLE - FILLING LEVEL 

MAKE SURE THAT THE LIQUID LEVEL OF THE WASTE BOTTLE IS 
ALWAYS KEPT BELOW THE MAXIMUM LEVEL INDICATED ON THE 

BOTTLE TO AVOID POTENTIAL OVERFLOW. AS THE CONTENTS OF 
WASTE BOTTLE ARE POTENTIALLY INFECTIOUS, WEAR 

PROTECTIVE CLOTHING (GLOVES, LAB COAT AND SAFETY 
GLASSES) WHEN EMPTYING / HANDLING A WASTE BOTTLE. 

FOLLOW LOCAL STANDARD OPERATING PROCEDURES ON HOW 
TO TREAT POTENTIALLY INFECTIOUS MATERIAL FOR DISPOSAL. 

Priming is performed to fill the liquid system of the HYDROFLEX Washer with 
liquid and to remove all air from the tubes. A priming step must also be performed 
when switching between buffers.  
If different wash buffers are used in a wash program, the instrument performs a 
prime step automatically.  
If the instrument will be left to stand for a longer time, priming must be performed 
to remove all liquid from the system. For this purpose, remove all tubes from the 
liquid bottles. 



3.  General  

64 HydroControl No. 30064355 Rev. No. 2.5 2017-12 

Priming can be performed by selecting Prime in the Instrument menu or by 

clicking the Prime button .  
The following dialog box appears: 

 
In the Channel area select the Channel to be primed (1 – 4) and then adjust the 
prime Time (between 5 and 99 seconds) or the volume (15 – 820 ml). 
The lowest time and volume to fill the liquid system completely are 10 seconds or 
30 ml. 
Click Start to start the prime procedure. 
Click Stop to abort the procedure. When the prime procedure has ended, the 
Prime dialog box close automatically. 

 

Note 
If the priming step is not performed properly, this can seriously 

influence wash results. 

 

3.17 Rinsing 
Rinsing is performed to flush the liquid system and to prevent needle blockages. 
The rinsing procedure should be performed, if the instrument is left to stand or is 
switched off at the end of operation. 
The two rinsing modes are: 

Day Use if the instrument will be left to stand for a short time. 
When Day is selected, a Time can also be selected (in seconds). 
Rinse day can be performed with the liquid already in use. 

Night For thorough rinsing and if the instrument will be left to stand for a 
longer time.  
When Night is selected the Time cannot be set. 
Rinse Night must be performed with distilled water only. 
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To perform a rinse procedure, select Rinse from the Instrument menu or click 

the Rinse button  and the following dialog box appears:  

 
Select a Channel and a Mode. 
Select the duration Time (5 to 99 seconds) or the volume (15 – 820 ml).  
Click Start to start the rinse procedure. 

 
Click Stop to abort the procedure. When the rinse procedure has finished, the 
needles of the manifold will remain in the liquid until the user presses Stop. Click 
Close to return to the main window during or after the rinse procedure. 

 

CAUTION 
RINSING IS THE MOST IMPORTANT DAILY CLEANING PROCEDURE FOR 

THE HYDROFLEX WASHER AND IS ESSENTIAL TO ENSURE PROPER 
WASH PERFORMANCE. FOR DETAILS, SEE THE INSTRUCTIONS FOR 

USE FOR THE HYDROFLEX WASHER. 

 

3.18 Empty Prime Tub 
Select Empty Prime Tub from the Instrument menu to remove the liquid from 
the prime tub. The manifold will move to the prime tub and the liquid will be 
aspirated out of the tub. 
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4. User Administration 
There are three types of administrators mentioned in this publication: 
The System Administrator is responsible for any changes made to the 
computer’s operating system. System Administrator rights are necessary to install 
the HydroControl software on the computer. 
The User Administrator is responsible for adding users and modifying user 
rights, adding user roles and modifying user role rights, assigning initial 
passwords, and changing user administration options within the HydroControl 
software. 
The Hydro_Administrator is a specific User Rights Role within the HydroControl 
software. A user who has assigned this role has access to all features of the 
HydroControl software, except for those related to the user administration. See 
4.1 User Rights for further information. 

 

CAUTION 
IT IS RECOMMENDED THAT ANYONE WHO USES THE HYDROCONTROL 

SOFTWARE HAVE “NORMAL” USER RIGHTS ON THE OPERATING 
SYSTEM (AND NOT SYSTEM ADMINISTRATOR RIGHTS)! 

4.1 User Rights 
There are three different default security levels of user rights, the highest level of 
which is Hydro_Administrator, a user who has assigned this role (security level) 
has access to all program functions, except for those related to the user 
administration. The Hydro_Application_Specialist and Hydro_Operator 
security levels are increasingly limited. 

 

Note 
HydroControl offers password protection to prevent misuse of the 

software and restricts access to parts of the software based on user 
rights. 

Each right can be assigned or withdrawn from a role by a User Administrator and 
by default are assigned as stated below.  
The default set of rights is based on a typical laboratory environment. 

 

CAUTION 
USER ADMINISTRATORS HAVE THE RESPONSIBILITY OF MAKING 

SURE THAT THE SETTINGS (AND ANY MODIFICATIONS) MATCH THE 
LABORATORY ENVIRONMENT DEFINED BY THE USER SOPS 

(STANDARD OPERATING PROCEDURES) AND COMPLY WITH ALL 
NATIONAL, REGIONAL, AND LOCAL LAWS. 
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The following table shows the User Administrator rights and default User 
Rights:  

User Rights 
Hydro_ 

Operator 

Hydro_ 
Application_ 

Specialist 
Hydro_ 

Administrator 
User 

Administrator 

Add Users and  
Modify User rights    X 

Add User Roles and  
Modify User Roles rights    X 

Assign initial passwords    X 

Change user 
administration 
options    

X 

Run programs X X X  

Edit programs  X X  

Save programs  X X  

Download programs  X X  

Sign documents   X  

Modify signed documents   X  

Edit plate parameters   X  

Set instrument parameters   X  

Edit lists   X  

Lock a Program   X  

Select Lanuage   X  

 
 

 

Note 

It is recommended that the User Administrator NOT have any User Rights 
on the HydroControl software (i.e. should not be assigned the role of: 

Hydro_Administrator, Hydro_Application_Specialist, 
Hydro_Operator or any custom defined roles). 
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4.1.1 Logging in for the First Time 
When HydroControl is started for the first time, a message appears informing that 
a User Administrator must be created first.  

 
Click OK and the Create Administrator dialog box appears.  

 
Enter a user name, full name, password, confirm the password and click OK to 
save the settings. At least one User Administrator must be created. 
Observe common sense guidelines when creating a password, so that it is strong 
and not easily forgotten. 
In case the Administrator password gets lost, the password cannot be recovered 
and HydroControl must be uninstalled and installed again. 

 

CAUTION 
IF THE USER ADMINISTRATOR PASSWORD IS FORGOTTEN, USER 

ADMINISTRATION SETTINGS CANNOT BE CHANGED AND 
HYDROCONTROL MUST BE COMPLETELY REINSTALLED (THE 

SOFTWARE MUST FIRST BE COMPLETELY UNINSTALLED AND THEN 
INSTALLED AGAIN, NOT INSTALLED “OVER” THE ALREADY 

INSTALLED SOFTWARE). 

 

Note 
It is recommended that at least two User Administrators are created. 
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After clicking OK, the User Administration dialog box appears: 

 
Users and roles can be added, edited, or deleted and user rights can be defined. 
Options for login, password, and email can be edited. 
The User Administration dialog box contains the following elements: 
 

Roles The roles list shows all existing roles (user levels).  

Add Role A new role with corresponding rights can be created. 

Modify Role Rights of an existing role can be modified 

Users The users list shows all existing users and their roles.  

Add User A new user can be created. 

Modify User Full name, user level (role) or password of an existing 
user can be changed 

Change 
Password 

Press this button to change the password. 

Audit Trail The audit trail shows all modifications of the user 
administration database (e.g. creation of roles/user, 
change of rights, change of options, …) 

Options General login, password or email options can be modified 

Summary A summary of all roles and users is displayed. 

Initial Password 
When a user logs in for the first time, the password must be changed.  
After entering the User name and Password and clicking OK, the following 
message appears:  

 



 4.  User Administration 

2017-12 HydroControl No. 30064355 Rev. No. 2.5 71 

The initial password is only valid once and expires after three days. If the initial 
password is not used within three days, the password expires and a new 
password must be assigned by the HydroControl_Administrator, (this does not 
apply to Admin, see 2.1 User Administration Quick Start). 
The user must enter the old password then the new password. The new 
password must be confirmed to prevent typing errors. 

 
The new password will expire after a specified period of time, see Password 
Expiration. 

Login 
Each time HydroControl starts, the Login dialog box appears:  
Enter the Username and Password and click the green arrow to continue. 
The user account will be disabled after the maximum number of consecutive 
unsuccessful logins has been reached (see Application Locked). 
The Login dialog box contains the following elements: 

User Name 
text box Enter your User Name. 

Password 
text box Enter your Password. 
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Auto Login 

 
Select Enable Auto Login to allow users to log in without entering username and 
password. 
Only an Administrator can enable or disable the automatic login. 
If Auto Login is enabled, the HydroControl software is no longer compliant with 
FDA regulation 21 CFR Part 11 for electronic records and signatures. 
 
When Auto Login function is used, we recommend to increase the password 
expiration time (max. 36500 days; menu: Tools/ User Administration/ Options/ 
Password). 
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4.1.2 Add/ Modify Role 
Click Add Role or Modify Role in the User Administration dialog box and the 
Add/ Modify Role dialog box appears: 

 
 
The Add/ Modify Role dialog box contains the following elements: 

Role Name A unique role name has to be entered when a new role is 
created. This name cannot be modified afterwards. 

Rights The role represents a specific user level and corresponding 
user rights can be selected. 
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4.1.3 Add/ Modify User 
Click Add User or Modify User in the User Administration dialog box and the 
Modify User dialog box appears: 

 
The Modify User dialog box contains the following elements: 
 

User Name A unique user name has to be entered when a new user is 
created. This name cannot be modified afterwards. 

Full Name Enter the full name of the user. This can be changed later. 

Roles Select the role of the user. 

Change 
Password 

The initial password is only valid once and expires after 
3 days. The password must be changed at next login. 

Rights 

Roles Select from one of the existing roles. The rights associated 
with that role are assigned to the user. 

4.1.4 User Administration Audit Trail 
Click Audit Trail in the User Administration dialog box and the User 
Administration Audit Trail dialog box appears: 
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The audit trail shows a list of all modifications of the user administration 
database. Each entry consists of the user (name and full name), date and time of 
change and what has been changed. 
The text can be copied to a word processing program for printing. 

4.1.5 User Administration Options 
Click Options in the User Administration dialog box and the User 
Administration Options dialog box appears and has the following tabs: Login, 
Password and Email. 

Login Options 

 
 

Auto Lock If the user doesn't use the application for a specified time  
(1 min - 24 hours), the application is automatically locked and 
the user has to reenter the password. 

Unsuccessful 
logins 

After a number of consecutive unsuccessful logins (1 - 10), 
the user account is locked and optionally an alert email is 
sent to the system administrator. 

 

Application Locked 

 
If the application has not been in use for the specified maximum time it will be 
locked. The password must be entered to unlock the application. See Auto Lock 
above. 
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Password Options 

 
Passwords must fulfill minimum requirements. The minimum length of passwords 
can be set (5 - 99) and passwords can optionally contain numeric digits.  

Password Expiration 
Passwords expire after a specified interval (1 - 365 days) and must be changed. 
Passwords cannot be reused. When the password expires, the user will be 
prompted to enter a new password. 

 
The New Password must comply with the specified password rules and has to 
be entered twice to prevent typing errors. 
Old passwords cannot be reused. 
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Email Options 

 
An administrator can be notified in case of potential security attacks (a user 
account has been locked because a number of unsuccessful logins). 
An email can be sent to the entered email address: 
• Mail to: insert the respective e-mail address 
• Send by SMTP: the IP address of the SMTP server has to be entered 
Click Test Mail to send a test mail to verify that the settings are correct. 

4.1.6 User Administration Summary 
A detailed description of all existing users and roles as plain text can be obtained 
by clicking Summary in the User Administration dialog box. 

 
The text can be copied to a word processing program for printing by clicking 
Copy to Clipboard. 
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4.1.7 Select Language 
Use the command Select Language from the Tools menu to change the 
language of the HydroControl software and the displayed language on the 
instrument. The software needs to be closed after selecting a new language. 
Restart the application; HYDROFLEX needs to be connected again.  

4.1.8 Change User 
Select Change user from the Tools menu to logout the current user and to login 
a different user. 
In the header of the main window, the name of the current user is displayed in 
brackets: 

 

4.1.9 About HydroControl 
Select About HydroControl... in the Help menu to open the About 
HydroControl dialog box. 
All software relevant information is shown. 
Click OK to close the dialog box. 

4.2 Exiting HydroControl 
To exit the HydroControl software, select Exit from the File menu or click the 

close button  in the upper right hand corner of the main window. 
 
 

5. Trouble Shooting and Error 
Messages 

See the corresponding chapter in the instructions for use for HYDROFLEX. 
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